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사용설명서(v1.0)
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1. 설치 및 환경설정

001 컴퓨터 사양과 지원 운영체계

002 DelgaEditor v8 설치

■ 컴퓨터 사양

windows XP memory 2G / HDD 10G 이상  
windows7 64bit memory 4G / HDD 5G 이상

** DelgaEditor v8은 windows7 64bit에 최적화 되어 있으며 메모리는 많을수록 좋습니다. 

■ DelgaEditor를 DVD로 설치하는 경우   

1) Windows XP 사용자인 경우는 SP3를 먼저 설치합니다.
(service pack 3는 프로그램 DVD안의 SP폴더 안에 있습니다.) 

2) 프로그램 DVD안에 있는 delgaEditorSetup.exe를 실행시킵니다.

■ 지원운영체계

Windows XP 이상에서 지원되며 Windows XP에서는 service pack 3가 
설치되어 있어야 합니다. 

** DelgaEditor v8는 windows용 프로그램으로 Mac은 지원하지 않습니다

■ “델가” 홈페이지에서 다운 받아 설치하는 경우 

1) Windows XP 사용자인 경우 SP3를 먼저 설치합니다.
(DelgaEditor 홈페이지 자료실 또는 Microsoft 홈페이지) 

2) 홈페이지 프로그램 자료실에서 delgaEditorSetup.exe 파일을 다운 받아 설치합니다.   

■ Photoshop 환경설정

DelgaEditor에서 포토샵을 연동하여 사용하는 경우는 템플릿을 등록할 때와 포토샵의 액션기능을 이용하
여 리터치를 적용할 때입니다. 
이 경우는 아래와 같이 포토샵 환경설정을 해주어야 합니다.

1) 포토샵 메뉴 Edit > Preferences > File Handling을 선택합니다.
2) Maximize PSD and PSB File Compatibility 를 Always로 선택합니다.
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003 template 및 component 설치 

홈페이지에서 template 및 component를 다운받아 설치하는 경우는 홈페이지의 설치방법 안내에 따라 설
치합니다.

2. 화면구성과 도킹모드   

001 전체화면

① 메인 메뉴 창 
② 소스이미지 작업 창/컴포넌트 작업 창과 메뉴
③ 편집작업 창과 편집작업 창 메뉴
④ 템플릿 작업 창과 템플릿 작업 창 메뉴
⑤ 편집완성 창과 편집 완성 창 메뉴
⑥ 레이어 창(트리)과 레이어 창 메뉴
⑦ 레이어 속성 설정 창과 메뉴 

①

②

③

⑤

④

⑦

⑥
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004 각 작업 창의 도킹 On/Off 버튼

각 창의 도킹버튼 위치는 아래와 같고 이 버튼을 누르면 
해당창의 도킹이 해제되고 다시 한번 누르면 도킹 상태로 복구됩니다.
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005 각 작업 창 열/닫기 및 확대/축소 

■ 작업장 Extender(열기/닫기)버튼 

■ 마우스로 Grid splitter 잡고 드래그하여 확대/축소하기
각 작업창의 Grid splitter을 잡고 마우스로 드래그하여 확대 축소할 수 있습니다.
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3. 메인 메뉴창 

006 메인 메뉴

■ 파일 

① 새앨범  
: 새앨범 작업을 시작 메뉴

 
② 새앨범유형 

: 설정된 앨범사이즈와 dpi 작업환경으
로 새앨범 작업 시작메뉴 

③ 새 이미지
: 편집작업창의 빈 페이지를 새로 생성 
메뉴

  
④ 앨범불러오기 

: 완료된 또는 저장된 프로젝트(앨범) 열
기 메뉴

⑤ 사진불러오기 
: 소스이미지를 불러오기 메뉴
(소스이미지을 불러오는 방법은 win-
dows 탐색기에서 폴더나 소스이미지를 
선택하여 드래그하여 놓아도 됩니다)

⑥ 최근앨범불러오기 
: 최근작업한 프로젝트 불러오기 메뉴.  

  
⑦ 앨범저장하기 

: 작업중인 프로젝트내용을 저장하는 
메뉴 
(저장과 빌드는 다릅니다. 작업한 내용
으로 jpg, psd 그리고 avi 파일 등을 만
들려면              실행메뉴에서 앨범만
들기와 MovieMaker를 실행해야 합니다)   

⑧ 다른이름으로저장하기
: 작업중인 프로젝트이름을 다른 이름
으로 저장하기 메뉴  

                         
⑨ 종료 

: 프로그램을 종료합니다.

①

②

③

④

⑤

⑥

⑦

⑧

⑨



7

■ 편집 

① Undo  
: 작업중인 내용을 뒤로 돌리기 메뉴

 
② Redo  

: 되돌린 작업 내용을 다시 앞으로 돌리
기 메뉴 

③ 잘라내기
: 선택한 것을 잘라내기 할 때 
  

④ 복사 
: 복사 메뉴

⑤ 붙여넣기  
: 붙여넣기 메뉴 

⑥ 삭제 
: 선택한 것을 삭제 메뉴 

  
⑦ 전체선택  

: 편집화면에 있는 모든 레이어를 선택
하는 전체 선택 메뉴

■ 보기 

① Zoom in 
: 화면축소 메뉴

② Zoom out 
: 화면확대 메뉴

③ Fit on Screen 
: 편집작업창의 작업중인 템플릿을 화
면사이즈로 보기 메뉴

④ Actual Pixels 
: 편집작업창의 작업중인 템플릿을 실
제사이즈로 보기 메뉴

■ 레이어 

① Group layers 
: 레이어를 그룹으로 묶기 메뉴

② Ungroup layers 
: 레이어 그룹 해제 메뉴

③ Create Clipping Mask 
: Clipping Mask 씌우기 및 해제 메뉴 

①

①

①

②

②

②

③

③

③

④

④

⑤

⑥

⑦
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■ 실행 

① 앨범만들기 
: 작업한 앨범을 작업설정(25p)에 설정
된 대로 랜더링 합니다.

② 델가북만들기 
: DelgaBOOK 슬라이드 쇼를 제작 합
니다.

③ 델가북미리보기 
: 미리보기 이미지로 저 해상도의 Del-
gaBOOK 슬라이드 쇼를 제작 합니다.

④ 미리보기 jpg만들기 
: 작업한 앨범의 미리볼수 있는 작은 이
미지를 제작합니다.

⑤ Make Movie 
: DelgaBOOK 슬라이드 쇼를 동영상 파
일로 변환하는 MovieMake프로그램을 
실행 합니다.

⑥ 일괄작업관리자 
: 작업했던 앨범들을 일괄적으로 랜더
링할 수 있는 일괄작업 관리자창(32p)
을 엽니다.

⑦ 일괄작업목록추가 
: 작업 중인 앨범을 일괄작업 목록에 추
가 합니다.

①

②

③

④

⑤

⑥

⑦
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■ 설정 

① 작업설정 
: 출력, 결과물에 관한 작업설정(25p)을 
할 수 있습니다.

② 환경설정 
: 프로그램 사용 환경설정을 할 수 있습
니다..

③ Language  
: 언어를 선택합니다.

④ Photoshop 
: 연동되는 포토샵 버전을 선택합니다. 

⑤ 시작시 앨범유형창 표시 
: 프로그램 시작시 등록된 앨범 유형을 
선택하는 창을 활성화 할 수 있습니다.

⑥ 자동일괄작업등록 
: 편집한 앨범을 저장할때 일괄작업 목
록에 자동으로 저장합니다.

⑦ Editor Layout -> Reset Default style 
: 편집 화면 레이아웃을 기본으로 변경
합니다.

■ 도구 

① 앨범자동편집 
: 이미지 창에서 선택된 이미지 그룹에 
있는 모든 이미지를 템플릿 창에 선택된 
템플릿 그룹의 템플릿에 순차적으로 자
동으로 편집하는 기능입니다.

② Size Template Editor 
: 등록된 앨범 편집 사이즈를 추가 수정 
할 수 있습니다.

③ Album Template Editor 
: 앨범 유형을 등록 관리 할 수 있습니
다.(설정 매뉴 의 (5) 시작시 앨범유형창 
표시 메뉴와 관련되어 있습니다)

④ 액션편집 
: 포토샵 액션을 등록, 관리 할수 있습
니다.

⑤ Windows탐색기 
: 편집중인 앨범이 저장된 폴더를 Win-
dows탐색기로 엽니다.

⑥ Internet Explorer 
: 델가 홈페이지에 접속합니다.

①

①

②

②

③

③

④

④

⑤

⑤

⑥

⑥

⑦
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■ Help 

① About 
: 프로그램 정보를 확인 합니다.

② Online Help 
: 홈페이지 Help Page에 접속 합니다.

①

②

007 툴바

① 새앨범 : 새 앨범을 작업합니다.

② 앨범불러오기 : 앨범을 불러옵니다.

③ 저장 : 편집중인 앨범을 저장합니다 (최종 출력물이 저장되는겅이 아니라 편집한 소스가 저장됩니다)

④ 종료 : 프로그램을 종료 합니다.

⑤ UNDO : 편집 작업을 한단계 이전으로 되돌립니다..

⑥ REDO : 편집 작업을 한단계 앞으로 복원합니다

⑦ Zoom in / Zoom out: 편집화면을 확대 축소 합니다.

⑧ Fit on Screen : 편집 이미지 크기를 편집화면에 맞게 조절 합니다.

⑨ Actual Pixels : 편집이미지 크기를 원본 크기로 조절합니다.

⑩ 앨범만들기 : 작업한 앨범을 작업설정(25p)에 설정된 대로 랜더링 합니다.

⑪ 델가북만들기 : DelgaBOOK 슬라이드 쇼를 제작 합니다.

⑫ 델가북미리보기 : 미리보기 이미지로 저 해상도의 DelgaBOOK 슬라이드 쇼를 제작 합니다.

⑬ Windows 탐색기 : 편집중인 앨범이 저장된 폴더를 Windows탐색기로 엽니다.

⑭ Internet Explorer : 델가 홈페이지에 접속합니다.

① ② ③ ④ ⑤ ⑥ ⑩⑦ ⑪⑧ ⑫⑨ ⑬ ⑭
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① 이미지 작업창 분리 또는 도킹 버튼 : 이미지 작업 창을 독립 창으로 분리하거나 
메인 프로그램 창에 도킹할 수 있습니다.

② 이미지 작업 창과 컴포넌트 작업 창 전환 : 컴포넌트 작업 창과 이미지 작업 창 사이를 전환 합니다. 

③ 사진(이미지) 불러오기 : 사진을 불러옵니다.

④ 삭제 : 선택한 사진을 삭제 합니다.

⑤ 이미지 - 90회전 : 선택한 사진을 시계 반대방향으로 90 회전 합니다.

⑥ 이미지 + 90회전: 선택한 사진을 시계 방향으로 90 회전 합니다.

⑦ 좌우반전 :  선택한 사진을 좌우 반전 합니다.

⑧ 상하반전 :  선택한 사진을 상하 반전 합니다.

⑨ 이미지 확대/축소 선택 : 편집 창으로 사진을 드래그 할 때 사진을 솩대 혹은 축소 해서 볼 수 있습니다.

⑩ 이미지 정렬(Sort) 메뉴 : 이미지를 전체, 그룹별, 시간별 로 정렬 합니다

⑪ 이미지 확대축소 바 : 이미지를 확대 축조 합니다.

⑫ 이미지 팔레트간 이동버튼 : 여러 이미지 그룹이 있을 때 선택한 그룹을 좌 우로 이동합니다.
(다른 폴더의 사진을 불러올 때 각각의 그룹으로 분류됩니다) 

⑬ 이미지 팔레트 목록보기 : 여러 그룹을 리스트로 봅니다.

4. 이미지(source) 작업창/컴포넌트 작업창  

008 이미지(source) 작업창 

① ② ③ ④ ⑤ ⑥ ⑩⑦ ⑪⑧ ⑫⑨ ⑬
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① 컴포넌트 작업 창 분리 또는 도킹버튼 : 컴포넌트 작업 창을 독립 창으로 분리하거나 
메인 프로그램 창에 도킹할 수 있습니다.

② 소스작업 창 모드와 컴포넌트 작업장모드로 전환 버튼(단축 F3) 
: 컴포넌트 작업 창과 이미지 작업 창 사이를 전환 할 수 있습니다. 

③ 컴포넌트 불러오기 버튼 : 컴포넌트 파일을 불러 옵니다.

④ 삭제버튼 : 선택한 컴포넌트를 삭제 합니다.

⑤ 컴포넌트 정렬(Sort) 메뉴  : 컴포넌트를 를 전체, 그룹별, 시간별 로 정렬 합니다

⑥ 컴포넌트 확대축소 바  : 컴포넌트 이미지를 확대 축소 합니다.

⑦ 컴포넌트의 팔레트 간 이동버튼 : 컴포넌트 그룹을 좌우로 이동 합니다.

⑧ 컴포넌트 팔레트 목록보기 버튼 : 여러 그룹을 리스트로 봅니다.

009 컴포넌트 작업창 

① ② ③ ④ ⑤ ⑥ ⑦ ⑧
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① 새 템플릿(페이지) 생성 메뉴 : 비어있는 새 탬플릿(페이지)을 생성 합니다.

② 편집완성페이지이동 메뉴  : 편집한 템플릿(페이지)를 편집 완성 창으로 등록 합니다.

③ 편집중인 템플릿 삭제 버튼 : 편집중인 템플릿을 삭제 합니다.

④ 편집화면 확대축소 메뉴  : 편집중인 템플릿을 확대,축소 합니다.

⑤ 포토모드와 컴포넌트모드 전환버튼** : 사진 편집모드, 컴포넌트 편집모드로 전환 합니다.

⑥ 작업중인 템플릿 사이즈 변경버튼 : 편집중인 탬플릿 사이즈를 변경합니다

5. 편집작업 창 

010 편집작업 창 메뉴  

011 편집기능 

① ② ③ ④ ⑤ ⑥

■ 사진모드와 컴포넌트 모드 

편집에 있어서 가장 기본적으로 알아야 할 
것은 사진작업을 할 때는 사진모드에서 하
고, 사진틀이나 아이콘과 같은 컨포넌트을 
작업하고자 할 때는 컴포넌트 모드에서 작
업을 해야한다는 것입니다. 

사진모드와 컨포넌트 전환메뉴는 이미지
소스 작업창과 편집작업창에 있습니다.
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1) 이미지 넣기 
: 사진을 템플릿에 넣을 때는 선택한 
사진을 드래그하여 템플릿의 사진이 
들어가는 회색영역에 놓으면 됩니다.

■ 이미지 넣기와 삭제, 이동, 확대축소, 회전 

Drag

2) 이미지삭제
: 넣은 이미지를 삭제할 때는  De-
lete 키로 삭제하면 됩니다. 
이미지 삭제는 포토모드일 때만 삭제
가 되고 컴포넌트 모드일 때는 컴포
넌트가 삭제됩니다

3) 사진이동 
: 템플릿에 넣은 사진을 다른 위치로 
이동하고자 할 경우는 마우스의 왼쪽
버튼을 누른 상태에서 이동하시면 됩
니다. 

4) 사진확대, 축소 
: 사진을 선택하고 마우스의 휠 버튼
을 사용하거나 사진 영역 네 구석의 
둥그런 영역을 선택하여 확대 축소할 
수 있습니다.
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■ 사진틀모드로의 전환과 사진틀 이동 및 변경 

5) 회전 
: 이미지의 영역을 표기하는 빨강색
선 외각에 마우스를 가져다 대면 마
우스의 커서가 회전모양으로 바뀝니
다. 
회전모양의 커서를 잡고 회전하시면 
됩니다.

2) 컴포넌트 삭제 
: 작업중인 컴포넌트를 삭제하고자 
할 경우 Delete 키로 삭제하면 됩니다.
컴포넌트 삭제는 컴포넌트 모드일 때 
만 삭제되고 포토모드일 때는 이미지
가 삭제됩니다.

3) 컴포넌트 이동
: 작업중인 컴포넌트를 이동 할 때는 
마우스의 왼쪽버튼을 누른 상태에서               
이동하면 됩니다. 

4) 컴포넌트 확대, 축소 
: 작업 중인 컴포넌트를 선택하고 마
우스의 휠버튼을 사용하거나 작업중
인 컴포넌트 영역 네 구석의 둥그런 
영역을 선택하여 확대 축소할 수 있
습니다.

1) 컴포넌트모드로 전환 
컴포넌트를 변형, 삭제 이동, 추가하
려고 할 때는 컴포넌트 모드로 전환
해야 합니다.
포토모드와 컴포넌트모드의 전환은 
포토모드와 컴포넌트모드 전환버튼 
또는 F2 단축키로 전환하면 됩니다.    

Select
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5) 회전 
: 작업중인 컴포넌트을 회전할 때는 
컴포넌트 영역인 초록색선 외각에 마
우스를 가져다 대면 마우스의 커서가 
회전모양으로 바뀝니다. 
회전모양의 커서를 잡고 회전하시면 
됩니다.     

1) 소스이미지 창/컴포넌트 창 전환버튼을 
눌러 컴포넌트 창 모드로 바꿉니다. 

1) 편집작업창을 포토모드로 변환합니다

2) 컴포넌트 창 내의 컴포넌트 팔레트 그
룹들 중에서 icon, 배경, 레이아웃 등을 선
택한 후 마우스로 드래그하여 편집작업창
의 템플릿 위에 놓으면 됩니다. 

2) 색상 조정을 하고자하는 사진을 선택하
고 속성창의 "ColorCurve"의 커브 선을 이
용하여 조정합니다

■ 컴포넌트창의 icon, 배경, 레이아웃 등을 작업중인 템플릿에 넣고자 할 때    

■ 사진 명암 조정

Click

Drag

Click

Set
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■ 글쓰기

① 레이어작업 창의 레이어 추가 버튼을 "+" 
누르고 text 레이어를 선택합니다

② 텍스트 레이어가 생성되면 아래와 같이 텍
스트 레이어 속성 창이 활성화됩니다. 

③ 텍스트 레이어 속성 창에 텍스트를 입력하
고 텍스트 자간거리, 행간거리, 크기, 투명도, 
테두리 넣기 등의 효과를 넣습니다  

④ "Fit to Region" 버튼을 클릭하면 텍스트 레
이어 창의 크기에 맞게 자동으로 설정되어 창
의 크기를 적절하게 변형하면 자동으로 그 크
기에 맞추어집니다

①

②

③

④

③

Click
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6. 템플릿 창 

012 템플릿작업 창 메뉴   

013 템플릿사이즈 설정과 Auto Resize  

① ② ③ ④ ⑤ ⑥ ⑦ ⑧ ⑨

① 템플릿작업 창 분리 또는 도킹버튼
: 컴포넌트 작업 창을 독립 창으로 분리하거나 메인 프로그램에 도킹할 수 있습니다.

② 템플릿 불러오기 버튼 : 템플릿을 불러옵니다.

③ 삭제버튼  : 선택한 템플릿을 삭제합니다.

④ 이미지 정렬(Sort) 메뉴 : 템플릿을 전체, 폴더별, 날짜별로 정렬 합니다.

⑤ 이미지 확대축소 바 : 템플릿 이미지를 확대 축소 합니다.

⑥ 앨범 사이즈 설정 버튼 : 앨범 사이즈를 설정합니다.

⑦ AutoResize : 템플릿을 편집 창으로 불러올 때 템플릿을 앨범 사이즈로 변경하는 버튼 

⑧ 템플릿 팔레트 간 이동 버튼

⑨ 템플릿 팔레트 목록보기 버튼
            

기본적으로 템플릿사이즈(출력물 사이즈)는 처음 등록한 psd 사이즈와 출력 dpi가 적용됩니다. 
등록된 사이즈 외에 다른 사이즈로 설정하고자 할 때 

①②

① "Auto Resize" 버튼을 클릭하여 활성화시
킨다. 

② 사이즈설정 버튼을 클릭하여 원하는 사이
즈를 설정한다.  
                        
주의: "Auto Resize" 버튼이 활성화되지 않으
면 사이즈를 설정해도 적용되지 않습니다  
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014 원하는 템플릿을 모아 사용하는 방법    

■ 원하는 템플릿을 드래그하여 우측 편
집 완성 창으로 이동합니다 

■ 등록할 템플릿을 선택합니다
(Shift, Ctrl키 사용)

■ 마우스 오른쪽버튼을 클릭하여 Copy 
To Template 메뉴를 선택합니다

■ 새로 그룹을 만들 경우 <New Direc-
tory>항목을 선택하고, 등록되어있는 그룹
에 추가하려고 하면 그룹 이름을 선택하면 
됩니다. 

Drag

Click

Click
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7. 편집완성 창

013 편집완성 창 메뉴   

■ 편집완성 창은 편집이 완성된 페이지 모음 창입니다.

① 작업 창 분리 또는 도킹버튼  

② 편집완성 페이지 불러오는 메뉴

③ 편집완성 페이지 삭제 메뉴 

④ 편집완성 페이지 등록 메뉴 
: 편집작업 창에서 드래그하여 가져 올 
수도 있습니다

⑤ 편집완성 페이지 작업 창으로 가져가기 버튼
: 편집작업 창에서 드래그하여 가져다 
놓을 수도 있습니다.

⑥ 완성이미지 확대 축소 슬라이드 바

⑦ 편집완성 페이지 순서조정  
: 완성된 페이지를 드래그하여 위 아래
로 순서를 조정할 수 있습니다           

① ② ③ ④ ⑤ ⑥

⑦ Drag

8. 템플릿 레이어작업 창(트리) 

014 템플릿 레이어작업 창 메뉴

■ 편집작업창의 작업중인 페이지의 레이어작업 창입니다

① 작업 창 분리 또는 도킹버튼   

② 빈 레이어, 텍스트 레이어, 사진 레이어 추
가생성 메뉴

③ 레이어 삭제 메뉴 

④ Clipping Mask 씌우기 및 해제 메뉴 

⑤ 레이어 그룹화 메뉴 

⑥ 레이어 트리 확대, 축소모드 전환 메뉴

⑦ 각 레이어 이동
: 레이어를 선택하고 드래그하여 이동
합니다

① ② ③ ④ ⑤ ⑥

⑦ Drag
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① 작업 창 분리 또는 도킹버튼  
 
일반

② 이름 : 레이어 이름을 설정 합니다.

③ 투명도 : 레이어 투명도를 설정합니다.

④ ColorCurve 
: 사진 이미지의 톤 커브를 조절합니다.

⑤ Channels 
: 톤, 혹은 색상별로 커브 조절 합니다.

⑥ Type : 커브 유형을 설정 합니다.

⑦ Clear : 커브를 초기화 합니다.
   
DelgaBOOK

⑧ 동작
: DelgaBOOK 슬라이드쇼의 모션을 선
택합니다.       

⑨ StopPoint
: 프레젠테이션 모드 일시 정지 시점 설
정  

그림자효과     

⑩ 색상 : 그림자 색상을 설정 합니다.

⑪ 방향 : 그림자 방향을 설정 합니다

⑫ 투명도 : 투명도를 설정합니다.

⑬ 반지름 
: 그림자의 흐림 정도의 범위를 설정 합
니다.

⑭ 깊이 : 그림자의 깊이(강도)를 설정 합니
다.
 

9. 각 레이어 속성설정 작업 창  

014 각 레이어 속성설정 작업 창 메뉴

■ 템플릿 안의 텍스트, 사진, Delga-
BOOK의 모션 등 각 레이어들의 효과를 
설정하는 작업 창입니다.  

①

②

③

④

⑤
⑥ ⑦

⑧

⑨

⑩

⑪

⑫

⑬

⑭
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텍스트 레이어 속성 창 

① 볼드 : 텍스트를 굵게 강조 합니다

② 자간과 줄간 
: 글자 자간과 줄 사이의 간격을 설정합
니다.

③ Fit To Region 
: 텍스트 레이어 사각형 크기에 맞게 텍
스트 크기가 조절 됩니다.

④ 좌우정렬 
: 죄측, 중앙, 우측 정렬을 설정합니다.

⑤ 문단방향 : 글 쓰기 방향을 설정 합니다.

⑥ 글꼴선택 : 글꼴을 선택합니다.

⑦ 글꼴크기 : 글꼴 크기를 설정합니다.

⑧ 텍스트입력창 
: 텍스트를 입력하는 창입니다.

           
문자채우기

⑨ 채우기 색상 : 텍스트 색상을 설정합니다.

⑩ 채우기 투명도 
: 색상의 투명도를 설정합니다.

문자테두리 

⑪ 테두리색상 
: 문자에 태두리 선 색상을 설정합니다. 

⑫ 테두리굵기 
: 태두리 선의 굻기를 설정합니다.

⑬ 테두리투명도 
: 태두리 선의 색상 투명도를 설정합니
다.

①

②

③

④

⑨

⑩

⑪

⑫

⑬

⑤

⑥

⑦

⑧
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10. 프로젝트옵션 설정  

015 프로젝트옵션 설정 메뉴 

016 General(앨범)  

출력물의 사이즈와 종류 그리고 
DelgaBOOK 사이즈와 배경음악을 설정하는 
메뉴입니다.
상단메뉴의 "설정>작업설정" 으로 설정 할 수 
있습니다

① 출력물의 사이즈와 dpi 등록, 기본사이즈 
및 출력 dpi설정 

: 이 메뉴는 자주 사용하는 출력물 사이
즈와 출력 dpi을 등록하는 메뉴입니다. 

                                  
② 출력물 설정 

: 아래 설정화면에서 원하는 출력물 종
류를 선택합니다.  

①

②

Click
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017 DelgaBOOK 

① DelgaBOOK 사이즈 설정
: 메뉴창의 가로와 세로 사이즈 값을 설
정합니다     

② DelgaBOOK 배경음악 설정 
: "Add" 버튼을 눌러서 배경음악으로 사
용할 Mp3 파일을 추가합니다. 
배경음악으로 추가된 음악 중 선택하여 
우측으로 이동하면 배경음악으로 설정
됩니다. 
선택한 곡이 복수일 때는 위아래로 이동
하여 음악의 순서를 정할 수 있습니다.

①

②

11. 저장과 Build 

018 저장과 build  

■ 편집내용을 저장합니다 
(* 이때 저장되는 것은 편집한 정보가 담겨있
는 델가이미지 소스파일입니다)
메인 메뉴 > 파일 > 앨범저장하기 메뉴 혹은 
메인 메뉴 단축아이콘 앨범 저장하기 버튼을 
클릭

Click

■ 렌더링하여 결과물을 만듭니다
메인 메뉴 > 실행 > 앨범 만들기 메뉴 혹
은 메인 메뉴 단축아이콘 앨범 만들기 버
튼을 클릭

Click
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■ 옵션설정 창 
**10 프로젝트옵션 설정 참고

■ 결과물폴더

019 build 옵션   

① 저장한 앨범 이름의 폴더가 생성됩니다.

② 폴더 아래에 항목별로 저장 됩니다.

③ DelgaBOOK
: DelgaBOOK 슬라이드 쇼가 저장되는 
곳입니다

④ Jpeg
: 설정한 앨범사이즈로 출력할 수 있는 
JPG파일이 저장되는 곳입니다.

⑤ PreDelgaBOOK
: 미리 보기용 DelgaBOOK 슬라이드 쇼
가 저장되는 곳입니다

⑥ PreviewJpeg
: 미리 보기용 JPG파일이 저장되는 곳
입니다.

⑦ Psd
: 설정한 앨범사이즈로 PSD파일이 저
장되는 곳입니다.

⑧ UsedSource
: 편집에 사용된 원본 이미지가 저장되
는 곳입니다.

⑨ DLP 파일
: 편집된 템플릿과 이미지 정보가 저장
되어있는 델가 레이어 파일입니다.

⑩ DAP 파일
: 앨범 정보가 저장 되어있는 델가 앨범 
파일입니다.

① ②

③

④

⑩

⑤

⑥

⑦

⑧

⑨
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12. 환경설정

019 환경설정 메뉴 버튼   

환경설정 메뉴는 각 작업창의 작업환경을 설
정하는 페이지입니다. 
상단메뉴의 " 설정 > 환경설정 메뉴를 클릭하
여 설정 할 수 있습니다.Click
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020 General (일반설정) 

① Start with project template
: DelgaEditor가 시작할 때 사용자가 저
장한 프로젝트를 선택할 수 있는 화면을 
시작합니다. 

② Automatically added to the batch list
: 편집 후 앨범을 저장할 때 자동으로 
배치빌드 리스트에 추가합니다. 

①
②

①

②

021 Image Editor (이미지 편집 창 설정) 

① Show Guide Line
: 편집 창에 가이드 선 활성화 여부를 
선택합니다.

② Show Filename
: 편집중인 파일명 보기여부를 선택합
니다. 

①
②
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022 Source List (사진 창) 

Information(정보) 

① Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

② Show Image FileName
: 파일명 보기 여부를 선택합니다.

③ Show Image DateTime
: 이미지 생성 날짜 보기 여부를 선택합
니다.

④ Show Image Size
: 이미지 사이즈 보기 여부를 선택합니
다.

ToolBar(도구상자) 

⑤ Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

⑥ Open
: 열기 버튼 아이콘 활성화 여부를 선택
합니다.

⑦ Close
: 닫기 버튼 활성화 여부를 선택합니다.

⑧ Rotate
: 회전버튼 활성화 여부를 선택합니다.

⑨ Flip
: 반전버튼 활성화 여부를 선택합니다.

⑩ Group Selector
: 시간 별 폴더 별로 선택할 수 있는 그
룹선택박스 활성화 여부를 선택합니다

⑪ Zoom Slider
: 확대 슬라이드 활성화 여부를 선택합
니다.

■ 소스이미지창의 파일정보 및 메뉴버튼의 
환경을 설정

①
②

③
④

⑤
⑥

⑦
⑧

⑨
⑩

⑪

② ③ ④

⑥ ⑦ ⑧ ⑨ ⑩ ⑪
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023 Component List (컴포넌트 창) 

Information(정보) 

① Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

② Show Image FileName
: 파일명 보기 여부를 선택합니다.

③ Show Image DateTime
: 컴포넌트 생성 날짜 보기 여부를 선택
합니다.

④ Show Image Size
: 컴포넌트 사이즈 보기 여부를 선택합
니다.

ToolBar(도구상자) 

⑤ Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

⑥ Open
: 열기 버튼 아이콘 활성화 여부를 선택
합니다.

⑦ Close
: 닫기 버튼 활성화 여부를 선택합니다.

⑧ Group Selector
: 시간 별 폴더 별로 선택할 수 있는 그
룹선택박스 활성화 여부를 선택합니다.

⑨ Zoom Slider
: 확대 슬라이드 활성화 여부를 선택합
니다.

■ 소스이미지창의 파일정보 및 메뉴버튼의 
환경을 설정

①
②

③
④

⑤
⑥

⑦
⑧

⑨

② ③ ④

⑥ ⑦ ⑧ ⑨
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024 Template List (탬플릿 창) 

Information(정보) 

① Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

② Show Image FileName
: 파일명 보기 여부를 선택합니다.

③ Show Image DateTime
: 템플릿 생성 날짜 보기 여부를 선택합
니다.

④ Show Image Size
: 템플릿 사이즈 보기 여부를 선택합니
다.

ToolBar(도구상자) 

⑤ Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

⑥ Open
: 열기 버튼 아이콘 활성화 여부를 선택
합니다.

⑦ Close
: 닫기 버튼 활성화 여부를 선택합니다.

⑧ Group Selector
: 시간 별 폴더 별로 선택할 수 있는 그
룹선택박스 활성화 여부를 선택합니다.

⑨ Zoom Slider
: 확대 슬라이드 활성화 여부를 선택합
니다.

⑩ Template Auto Resize
: 템플릿 자동 리사이즈 버튼 활성화 여
부를 선택합니다.

①
②

③
④

⑤
⑥

⑦
⑧

⑩
⑨

② ③ ④

⑥ ⑦ ⑧ ⑨ ⑩
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025 Album List 

Information(정보) 

① Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

② Show Image FileName
: 파일명 보기 여부를 선택합니다.

③ Show Image DateTime
: 템플릿 생성 날짜 보기 여부를 선택합
니다.

④ Show Image Size
: 템플릿 사이즈 보기 여부를 선택합니
다.

ToolBar(도구상자) 

⑤ Enabled
: 하단의 전체 옵션의 활성화 여부를 선
택합니다.

⑥ Open
: 열기 버튼 아이콘 활성화 여부를 선택
합니다.

⑦ Close
: 닫기 버튼 활성화 여부를 선택합니다.

⑧ Zoom Slider
: 확대 슬라이드 활성화 여부를 선택합
니다.

⑨ Edit
: 편집버튼 활성화 여부를 선택합니다.

⑩ Edit Done
: 편집 완료 등록버튼 활성화 여부를 선
택합니다.

①
②

③
④

⑤
⑥

⑦
⑧

⑩
⑨
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025 Batch Build (일괄작업) 

*Batch Build 옵션 설정은
메뉴 > 실행 > 일괄 작업 관리자 메뉴로 설정 
합니다. 

Build register Option (Out Select)

① Use Project Option 
: 프로젝트 작업시 각각 설정된 옵션값
대로 빌드하는 옵션 .

② Use Batch Option 
: 프로젝트 옵션과 Batch Option에 설정
한대로 빌드하는 옵션.

추가, 삭제, 및 작업순서 조정메뉴(up/down) 

③ Add 메뉴 
: Batch Build List에 편집한 프로젝트(앨
범)를 추가합니다.

④ Delete 메뉴 
: Batch Build List에 등록된 프로젝트(앨
범)를 삭제합니다

⑤ move up 메뉴
: Batch Build List에 등록된 프로젝트(앨
범)를 앞으로 조정 .

⑥ move down
:Batch Build List에 등록된 프로젝트(앨
범)를 위로 조정 뒤로 조정.

①
②

③ ④ ⑤ ⑥
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026 Index Page 

Paper(종이 설정) 

Size(사이즈 설정)

① Size
: 사이즈 설정 / 사이즈 설정 창 열기 버
튼 / 새 사이즈 등록버튼 .

② Width / Height 
: 가로, 세로 사이즈설정. 단위설정.

③ DPI 
: 해상도 설정

④ Margin(종이 여백 설정) 단위mm 
: 좌측, 상단, 우측, 하단 여백 설정

⑤ Header/Footer(상, 하단 여백 설정) 단위mm
: 상단, 하단 높이 설정

Image(이미지 설정) 

⑥ Images/Line
: 한 줄에 이미지 출력 되는 수

⑦ Image Margin (이미지 여백 설정) 단위 mm
: 좌측, 상단, 우측, 하단 여백 설정

Print(출력 설정)

⑧ Project Name
: 프로젝트 명 출력 여부 설정

⑨ Page Number
: 페이지 숫자 출력 여부 설정

⑩ Image FileName
: 이미지 파일명 출력 여부 설정

⑪ Image Index
: 이미지 번호 출력 여부 설정

⑥

⑦

⑧
⑨

⑩
⑪

①

②

③

④

⑤
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027 Window(창 설정)  

Window Docking(창 도킹여부 설정)

① LayerTreeView(레이어 창) 
: 하나의 윈도우로 도킹 / 독립 윈도우
로 분리

② LayerProperties(레이어 속성 창)
: 하나의 윈도우로 도킹 / 독립 윈도우
로 분리

③ AlbumImageList(편집 완성 창)
: 하나의 윈도우로 도킹 / 독립 윈도우
로 분리

④ TemplateImageList(템플릿 창) 
: 하나의 윈도우로 도킹 / 독립 윈도우
로 분리

⑤ SourceImageList(소스 이미지 창) 
: 하나의 윈도우로 도킹 / 독립 윈도우
로 분리

⑥ ComponentImageList(컴포넌트 창) 
: 하나의 윈도우로 도킹 / 독립 윈도우
로 분리

①

②

③

④

⑤

⑥

13. 단축키

편집 창에서 사진 편집모드, 컴포넌트 편집모드를 전환 합니다.

028 F2

029 F3

030 F5

031 F9

사진소스 창, 컴포넌트 창을 서로 전환 합니다.

편집 창 확대보기가 됩니다. 편집 창을 제외한 나머지 창은 축소가 됩니다.

작업한 앨범을 설정한 출력파일 형태로 제작합니다 
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032 등록할 PSD 템플릿 파일을 등록에 맞게 수정 

14. 템플릿 등록 방법

■ 이미지가 들어가는 영역을 각각의 레이어
로 제작합니다. 예를 들어 이미지가 3개 들어
가면 레이어 3개로 각각 이미지의 영역을 제
작합니다.

① 각 이미지(사진) 영역의 레이어 이름을 
“<U>”로 변경합니다.           
레이어 이름을 <U>로 바꾸어야 이 레이어에 
사진이 들어가는 레이어라는 것을 프로그램이 
인식하게 됩니다.
즉, 이미지가 들어갈 레이어 이름을 <U>로 바
꾸는 것이 가장 중요합니다.  

② 이미지가 들어가는 각 <U>이름의 레이어 
위에 새로운 빈 레이어를 만들어 클리핑 마스
크를 적용 합니다. 
<U>이름의 레이어 위에 새로 만든 레이어를 
선택한 후 포토샵 메뉴 Layer > Create clip-
ping mask (Alt+Ctrl+G)를 사용합니다.(포토샵 
CS3에 해당)

③ 각 컴포넌트 단위로 그룹을 묶는다  
델가에디터의 템플릿은 컴포넌트 단위로 구성
되기 때문에 그룹작업을 해야 합니다.
 이미지가 들어가는 두 개의 레이어(클리핑 
마스크레이어 포함)와 또 다른 이미지 프레임
과 같은 꾸며주는 레이어가 있다면 모두를 선
택해서 그룹화 작업을 하셔야 합니다.
포토샵 메뉴 Layer > Group Layers(Ctrl+G)를 
사용합니다.(포토샵 CS3에 해당)

[참고] 그룹작업을 하지 않아도 등록은 되지만 
컴포넌트 이동 시 각 레이어 별로 
이동하기 때문에 편집작업이 불편합니다.

①

②

③
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033 등록에 맞게 수정된 PSD파일을 DelgaEditor에 드래그하여 불러옵니다 

■ PSD를 등록할 때는 PhotoShop과 연동되
어 등록하게 됩니다. 
현재 DelgaEditor v8은 Photoshop cs1~cs5
까지 연동이 됩니다.        

① Photoshop과 등록과정이 끝나면 아래와 
같이 편집완성 창에 등록됩니다.   

② 편집완성 창에 등록된 템플릿을 선택한 후 
오른쪽 마우스를 클릭하고 copy to template 
메뉴를 선택하고, 등록을 원하는 템플릿 팔레
트폴더를 선택한 후 
등록을 마무리 합니다 

**새로 그룹을 만들어 등록 할 경우 <New 
Directory>항목을 선택합니다

①

②

034 컴포넌트 등록 

15. 컴포넌트 등록 방법

■ 아이콘이나 로고, 배경 등을 png(또는 jpg)
파일로 만듭니다. 

① 아이콘이나 로고, 배경 등을 드래그하여 
소스 창으로 불러옵니다.  

② 불러온 아이콘을 마우스로 선택한 후 오른
쪽 마우스를 누르고 아이콘 등록을 할 팔레트 
그룹을 선택하여 등록합니다. 

③ 팔레트 그룹 맨 위의 New Directory를 클
릭하면 새 팔레트에 등록 할 수 있습니다.

■ 등록된 아이콘 팔레트에 가서 기존 아이콘
과 같이 사용합니다.

①

②

③
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035 메뉴

16. DelgaBOOK

① 정지버튼
② 이전 페이지로 이동 버튼
③ 재생 일시 정지 버튼
④ 다음 페이지로 이동 버튼
⑤ 음 소거
⑥ 볼륨조절 슬라이드 바
⑦ 재생 슬라이드 바
⑧ 옵션 버튼

① 영상 재생 중 이미지를 화면 하단으로 드
래그 하면 해당 이미지를 선택할 수 있습니다.

② 화면에서 마우스를 클릭하여 선택한 이미
지 보기를 할 수 있습니다

① ② ③ ④ ⑤ ⑥ ⑦ ⑧

① Drag

②
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① 영상 크기 / 영상비율 
: 영상의 크기를 원본크기, 화면비율로 
설정 합니다. 
영상을 화면크기대비 설정한 비율로 확
대 및 축소 합니다.

속도

② 총 프레임수 
: 영상의 총 프레임 수입니다.

③ 초당 프레임 속도 
: 초당 제생되는 프레임속도 입니다.

④ 초당 프레임 속도를 조절하여 속도를 설정 
합니다

⑤ 사진과 사진 사이의 시간 간격 입니다.

⑥ 페이지 이미지가 완성되고 난후 다음 페이
지로 넘어가는 시간 간격입니다.

재생 모드 

⑦ 기본모드 
: 기본적인 재생 모드 입니다.

⑧ 임의의 애니매이션 모드 
: 사진에 설정한 애니매이션이 아닌 랜
덤하게 애니매이션이 진행 됩니다.

⑨ 수동 페이지 전환모드 
: 수동으로 한 페이지씩 볼수 있습니다.

⑩ 책장넘기기 애니매이션 모드 
: 책장을 넘기듯이 볼수 있습니다.

⑪ 프리젠테이션 모드 
: StopPoint로 설정한 정지 시점과 페이
지 마지막 부분에서 일시 정지가되고 클
릭하면 계속 진행되는 모드 입니다.

⑫ 배경색상
: 영상 배경색을 설정 합니다

⑬ 반복
: 반복 횟수 설정 및 무한 반복을 설정 
합니다.

⑭ 선택된 이미지 보기 
: 선택된 페이지를 화면 하단에 표시할 
수 있습니다.

⑮ Language 
: 언어를 설정 합니다.

036 옵션 창

①

②

③

④

⑨
⑩

⑪

⑫

⑬

⑤

⑥

⑦
⑧

⑭

⑮
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